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1.	  WHY	  MOVE	  TO	  A	  NEW	  SYSTEM?	  

• Due to stability problems with and lack of vendor support for our current email and calendaring 
software, ITS has decided it would not be in the University's best interest to update these systems. 

• Faculty and staff have expressed a desire for integrated email and calendaring with improved 
support for mobile devices. 

	  

2.	  WHY	  WAS	  MICROSOFT	  EXCHANGE	  SELECTED?	  

After extensive investigation and consultation, ITS decided, as have many other Universities, to move the 
current email and calendaring systems to Microsoft Exchange 2007. Since it is an industry-leading Microsoft 
product, we are confident that the required level of support will be there now and in the future. 

	  

3.	  HOW	  WILL	  THIS	  CHANGE	  AFFECT	  ME?	  

• You will have more reliable email and calendaring services. 
• If you currently use Outlook 2007, Thunderbird version 2.0 or newer, Entourage Web Services, or Mac OS 

X Apple Mail today, you may continue to do so after the move.  If you use any other email client, you 
will be asked to upgrade or switch to another program prior to your scheduled move day.   

• If you use Outlook 2003, we ask that you upgrade to Outlook 2007. 
• If you currently use WebMail (mail.bc.edu), you will use Outlook Web Access (OWA accessed from 

email.bc.edu) after the move. 
• If you currently use CampusTime via the web (cal.bc.edu), you will access calendaring through OWA 

after the move.  
• If you currently use Outlook with Oracle Connector for Outlook (OCFO) to access your calendar, you 

will no longer need OCFO. Outlook in the Exchange environment will provide full integration with 
calendar, contacts, and email. 

	  

4.	  OUTLOOK	  2007	  AND	  DELEGATES	  

In order to manage another person’s calendar or a resource calendar in Outlook 2007, you must first have a 
good understanding of how to use Outlook 2007 for your own email and calendaring. Chapters 2 and 3 of 
this book will introduce you to the basics of email and calendaring in Outlook 2007. Once you are 
comfortable working with your own calendar, Chapter 4 will explain how to use the calendaring tools to 
manage a calendar for someone else or a resource.  
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2.	  Email	  Basics	  
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1.	  RECEIVING	  EMAIL	  

You do not need to do anything special to receive new messages. Outlook will automatically check for and 
display new messages periodically.  However, you can force Outlook to check for messages at any time by 

clicking   in the toolbar. 

	  

2.	  WRITING	  AND	  SENDING	  EMAIL	  

Sending email from Outlook works very similarly to other email programs you have used.  To send 
messages from Outlook: 

	  

1. With your email displayed, click   in the toolbar. 

2. In the  field type the email address of the recipients. If you are sending to someone at 
Boston College, you only need to type their name (learn more about this in the next section). 
Separate multiple addresses or names using semi-colons, as shown below. 

 

3. If you need to send a copy to one or more people, enter their names in the  field the same 

way you would in the  field. 
 

4. Enter a subject for your message on the subject line. 

 
 

5. Type your message in the message body box. 

 
 

6. Click . 

Message	  Body	  
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3.	  GLOBAL	  ADDRESS	  LIST	  FOR	  ALL	  FACULTY,	  STAFF,	  AND	  STUDENTS	  

When using Outlook with Exchange, all email addresses for faculty, staff, and students are easily accessible 

through the Global	   Address	   List	   (GAL). When you type a faculty, staff, or student’s name in one of the 

address fields (To, Cc, or Bcc), Outlook checks to see if it can find the person’s name in the GAL. If it finds the 
name, it will underline it. If it cannot find the name, check the spelling and try again or search for the 

person in the GAL	  by clicking the , , or  buttons. Note that when searching the 

GAL	  by Name	  only, you need to search by first name, then last name. 

 

	  
	  

By default, the Bcc field is hidden. You can show the Bcc field by clicking the Options tab and pressing 
the Show	  Bcc button in the fields group. 

	  

To search by last name or other criteria, click the Advanced	  Find button. 
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4.	  CONTACTS	  

In addition to the GAL, Outlook also has a place to store your personal addresses.  This area is called 

Contacts. You can store information for people external to BC (people that don’t have an @bc.edu email 

address) in your Contacts. Examples of whom you might put in your Contacts	  include vendors, contractors, 

and colleagues at other institutions. When you type a contact’s name in the To, Cc, or Bcc field, Outlook will 

check to see if it matches an address in your Contacts after it checks the GAL. You should never store 

@bc.edu email addresses in your Contacts	  since this will conflict with the GAL and disable Exchange-specific 
features for messages you address to that member of the BC community. To create a new contact: 

	  
1. Access your contacts by clicking Contacts in the pane on the left. 

 
 

2. Click  to create a new contact. 
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3. Enter in as much or as little information as you want. 

 
 

4. Click . 
 

To edit an existing contact, view your	  Contacts	  and double-click the contact you want to update.	  

	  

5.	  SETTING	  AN	  OUT	  OF	  OFFICE	  MESSAGE	  

If you will be away from the office for a day or more with limited or no access to email, it is a good idea to 
set up an Out of Office message, which notifies anyone who emails you when you are away from the 
office. In the old email system, you would set an Out of Office message through WebMail. In BC’s new 
email environment, you set the Out of Office message through Outlook or Outlook Web Access. Exchange 
provides finer control over your Out of Office message, allowing you to set your message up well in 
advance of your absence and specify separate replies for colleagues at BC and external senders. To set up 
an Out of Office Message: 
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1. Go to Tools	  >	  Out	  of	  Office	  Assistant… 

	  
2. Select Send	  Out	  of	  Office	  auto-‐replies. 
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1. Check Only	  send	  during	  this	  time	  range and select the dates and times you will be out of the office. In 
the example below, Out of Office messages will be sent between 10 a.m. October 13, 2009 and 5 p.m. 
October 16. 
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2. Click the Inside	  My	  Organization tab and in the message box below, enter the message you want 

people at Boston College to receive while you are away. 
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3. When done writing your message, click the Outside	  My	  Organization tab and enter the message you 
want people from outside BC to receive while you are away. 

 
 

4. Click OK. 
 
When you return to the office, you do not need to disable the Out of Office message — it automatically 
disables itself based on the end time you specify. 
 
Some of the things you may want to consider including in your message are: 
• The dates you will be away from email 
• An alternate person that can be contacted during your absence 
• If you are willing to be contacted while you are away by people within your organization, you could 

include your cell phone or home number in your inside message 
 
To protect your privacy, it is a good idea not to divulge too much information in your Out of Office 
message, especially in the reply that you send to individuals outside BC. 
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6.	  SETTING	  UP	  A	  SIGNATURE	  

For your convenience, you can include a signature that is automatically added to all outgoing messages. A 
signature usually includes your name and contact information. To add a signature: 
 

1. Go to Tools	  >	  Options… 

2. Click the Mail	  Format tab. 
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3. Click the Signatures button. 

 
 

4. Click New. 
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5. Type a name for your signature and click OK. 

 
 

6. In the Edit	  signature box, type your signature as you would like it to appear on outgoing messages. 

 
 

7. If you want your signature to appear on all new messages you create, choose your signature from 

the New	  messages menu. 
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8. If you want your signature to appear on all replies and messages you forward, choose your 

signature from the Replies/forwards menu. 

 
 

9. Click OK. 
 

7.	  EMPTYING	  THE	  DELETED	  ITEMS	  FOLDER	  

As with other email programs you have used, messages you delete go to a trashcan. In Outlook the trash is 

called Deleted	  Items.   You should delete items from this folder periodically to free up space on the server 

and your computer. To empty deleted items go to Tools	  	  >	  Empty	  “Deleted	  Items”	  Folder. 

	  

8.	  MORE	  EMAIL	  FEATURES	  

Microsoft Outlook is a feature-rich email and calendaring program. We hope you will explore all that the 
software has to offer.  To learn about advanced email features such as formatting, priorities, and rules, use 
the Help built-in to Outlook or visit bc.edu/exchange. 
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3.	  Calendar	  Basics	  
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1.	  VIEWING	  YOUR	  CALENDAR	  

To view your calendar, click the Calendar button in the pane on the left. 

 
	  
You can view your calendar in one of three formats: a single day, a whole week, or an entire month. 

To view a single day at a time, click the Day tab above your calendar. 
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To view a whole week at once, click the Week tab above your calendar.  

 
 
To view an entire month, click the Month tab above your calendar. 
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2.	  RECEIVING	  AND	  REPLYING	  TO	  INVITATIONS	  

When you are invited to a meeting, you will receive an invitation by email. The event will also appear on 
your calendar and will be marked tentative. Email invitations are identifiable by the calendar icon as 
shown below. 

 
 
To reply to a meeting: 

1. Double-click the invitation to open it.  

2. Choose one of the options from the Respond group in the ribbon: 
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3. When you respond to a meeting, you will receive a dialog box asking if you want to 

• Edit	  the	  response	  before	  sending (include a message with your reply) 

• Send	  the	  response	  now (just notify the meeting organizer of whether you accept or decline) 
— OR — 

• Don’t	  send	  a	  response (does not notify the organizer of your response) 

Select a response then click OK.  

 
 

 

Once you respond to a meeting, the invitation will disappear from your mailbox. If you accept the meeting, 
it will remain on your calendar. If you decline the meeting it will not appear on your calendar. Never 
delete an invitation without replying to it. If you delete an invitation without replying, this will also 
delete it from your calendar and you will not be able to retrieve the meeting invitation. 

	  

3.	  CREATING	  AN	  APPOINTMENT	  

An appointment is an event only you attend. You might create an appointment to block out time for 
yourself to work on a project or attend a personal appointment, for example. To create an appointment: 
 

1. Click  while viewing your calendar. 
 

IMPORTANT: Outlook’s calendar is closely integrated with email. When replying to a meeting, always 

choose to either Edit	  the	  response	  before	  sending OR Send	  the	  response	  now. Do not use the Don’t	  send	  a	  

response option. If you select Don’t	  send	  a	  response, the organizer will not see whether or not you have 
accepted or declined the meeting. Your attendance status will only appear on your calendar. 
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2. Enter a subject for your appointment in the Subject line. 

 
 

3. Enter a location in the Location field (optional). 
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4. Enter the Start and End dates and times. 

 
 

 

5. Click . 

	  
 

When scheduling an appointment, Outlook will notify you if the time you select conflicts with another 
appointment on your calendar. 
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4.	  CREATING	  A	  MEETING	  INVITATION	  

A meeting is an event to which other people are invited.  You create a meeting in much the same way you 
create an appointment: 

	  
1. Click   while viewing your calendar. 

2. Click . Note that a  field similar to the one that appears in email is displayed. 

3. Type the names of invitees in the  field, or click  to select them from the GAL. 

 
 

To invite someone from outside BC to a meeting, type their email address in the  field. 
When you invite individuals who are not using an Exchange environment, they will only receive an 
email with the details of the meeting and will not see accept or decline buttons. This includes 
individuals at BC who are still using CampusTime or who are using an email client other than 
Outlook, Entourage, or iCal such as Thunderbird, as well as external recipients. 
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4. Click the Scheduling	  Assistant to see invitees’ availability. 

• Solid blocks of color indicate the individual is busy during that time period.  
• Forward leaning stripes /// indicate the person has something scheduled tentatively. 
• Backward leaning \\\ stripes indicate there is no information for that person. If there is no 

information for a person, it is likely that the individual is still using CampusTime and has not yet 
been moved to Exchange. If this is the case, you will need to log into CampusTime to see their 
availability.  

 
 

  

If someone is using CampusTime, you will not be able to invite them to the meeting using CampusTime, 

but you can view their availability there. To invite them, simply add them to the  field of your 
meeting invitation in Outlook and they will receive an email informing them of the meeting. 



	  

BC	  |	  Information	  Technology	  Services	   31	  

5. Enter a Subject for your meeting. 

 
 

	  
6. Enter a Location for the meeting EXCEPT if you are reserving a resource, such as a conference room 

or shared meeting space, for the meeting (see the next section for working with resources). 
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7. Select the Start and End times. 

 
 

8. If desired, enter a message in the body. 

 
 

Message	  Body	  
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9. Click . 
 

 
	  

• To edit a meeting once it has been created, find it on your calendar and double-click it to open. 

Make your changes, then click Send. The invitees will receive a notification that something about 
the meeting has changed. 

 
• As the organizer of a meeting, to reschedule an event you can click on it and drag it to a new date 

and time on your calendar. When you move the meeting, you will be prompted to send an update 
to invitees. 

	  

5.	  BOOKING	  A	  RESOURCE	  

Similar to CampusTime, you can reserve shared resources to which you have access, such as conference 
rooms, through Outlook. To reserve a room: 

	  
1. Create a meeting as described in the previous section, but leave the Location field blank. 

2. Click the Rooms button next to the location field. 

 
 

There are other ways to create meetings and appointments. For example, you can simply click on your 
calendar on the date and time that you want the event to be held and type a name for the event.  
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3. Search for the room you want to reserve. Note that resources have the same names that they had in 

CampusTime. 
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4. Select the room, then click the Rooms button at the bottom of the dialog box. 

 
	  
	  

5. Click . The reserved room now appears in the Location field. 

 
 
 

6. Verify the room is free using the Scheduling	  Assistant. If the room is already booked for that time, 
change the meeting time or choose a different room. 
 

7. Finish creating the meeting as you normally would. 
	  

6.	  CREATING	  A	  REPEATING	  APPOINTMENT	  OR	  MEETING	  

To create an event that repeats on a regular schedule, use the recurrence feature. To create a repeating 
meeting:  

1. Create your appointment or meeting as you normally would.  
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2. Click the Recurrence button on the toolbar. 

 
3. Specify the pattern you would like the recurring meeting to follow, for example every Tuesday. 
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4. Specify when the first and last meeting will be. Note that instead of specifying an end date, you can 
state how many times you want the meeting held. 

 
	  

5. Click OK and finish creating your meeting as you normally would. 
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7.	  PRINTING	  YOUR	  CALENDAR	  

Several calendar printing options are pre-defined and all can be customized further. To print your 
calendar: 

	  
1. Select the calendar you would like to work with. 

2. Choose Print from the File menu.  

3. In the Print	  style section, scroll to see the various styles available. 
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4. To print all meeting details, select: Calendar	  Details	  Style. Calendar	  Details	  Style prints a list view all 

the meeting details for the date or range of dates you specify. It will only include days that have 
meetings. 

	  
	  

Experiment with the other print styles to find the one that best meets your needs. 
 

To customize a predefined Print style: 
 

1. Click the Define Styles button to the right of the Print	  style section. 
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2. Select a	  Print	  style and click Edit. 

 
 

3. Change the options according to your own preferences.  
The first example below shows you how to print only the workweek not Saturday or Sunday. On 

the Format tab, check Only	  Print	  Workdays.  
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The second example shows you how to change the orientation, paper size, and paper feed. Click the 

Paper tab to change orientation, paper size, and printer paper feed. 

 
	  

8.	  MORE	  CALENDAR	  FEATURES	  

Outlook’s calendar functionality is much more robust than CampusTime’s was.  You will find as you use the 
calendar that there are multiple ways of doing the same thing and there are many great features to explore, 
such as color-coding events using categories and marking the importance of a meeting. Learn about these 
and other features of your Outlook calendar by using the built-in help or visiting bc.edu/exchange. 
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4.	  Working	  With	  Someone	  Else’s	  
Or	  A	  Resource	  Calendar	  
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1.	  ABOUT	  WORKING	  AS	  A	  DELEGATE	  

A delegate is someone who manages another’s calendar on their behalf. For instance, a manager or faculty 
member might have a staff assistant help maintain his or her calendar. As a delegate, you will work with 
the other person’s calendar as if it’s your own. Any change you make to their calendar will be visible to the 
calendar’s owner immediately. 
 
An individual may also be a delegate for a resource, such as a conference room, department LCD projector, 
or meeting space. Resources can be setup to either accept reservations automatically (no delegate required) 
or to require a delegate to accept the reservation manually. If you are a delegate for a resource calendar, 
you will work with the resource’s calendar as if it’s your own. 

	  

2.	  DELEGATE	  ACCESS	  

Before you can open someone else’s calendar or a resource calendar, you must be given access to it.  If you 
are unsure whether or not you have access to a calendar, ask the calendar’s owner.  To assign someone 
delegate access to a calendar you must be working on the computer from which you wish to share the 
calendar:  

1. From the Tools menu, select Options. 
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2. Click the Delegates tab and then click Add. 

 
 

3. Use the address book to locate the person you wish to add as a Delegate and click Add, then OK.  
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4. In the Options window, select the person’s name, then click Permissions. 

 
 
    

5. Choose the appropriate settings in the Delegate Permissions window.   
The levels of permission that a delegate can be granted are as follows: 

• Author: Can read, create, modify, and delete items that he/she has created on your behalf. 
For example, a delegate Author can create task requests and meeting requests directly 
in your Tasks or on your Calendar, and then the items on your behalf. 
 

• Editor: Can do everything an Author can do, plus modify and delete items you have created. 

• Reviewer: Can read items, for example a delegate with Reviewer permission can read 
messages in another person's Inbox. 
 

6. Select Automatically	  send	  a	  message	  to	  delegate	  summarizing	  these	  permissions so that your delegate(s) 
will be notified of the permissions you’ve granted them,	  then	  click	  OK. 
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7. When you are finished adding delegates, click OK to return to Outlook. 
 

To edit or remove a Delegate: 

1. From the Tools menu, select Options. 

2. Click the Delegates tab and select the delegate you’d like to edit or remove. Use the Remove button 

to delete a delegate. Use the Permissions button to edit a delegate. 

 
 

3. To edit a delegate, follow the steps outlined above for setting-up permissions. 
 
If you need additional assistance, contact the Help Center at ext. 2- HELP (2-4357).  

	  

3.	  OPENING	  A	  ANOTHER’S	  CALENDAR	  

Once you know that you have access to someone else’s calendar, you’ll need to open their calendar (you 
only need to do this the first time you want to view their calendar). To open a calendar: 
 

1. Make sure you are in Calendar view by clicking Calendar on the left. 
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2. Click Open	  a	  Shared	  Calendar… 

 
 

3. Click the Name button.  
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4. Search for and select the person or resource whose calendar you want to view, then click OK. 

 
 
 

5. Click OK.  
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The calendar you chose opens. Initially, you will see your calendar on the left and any other calendars you 
open on the right. The owner or resource appears at the top of the calendar. Your calendar is simply called 
“Calendar.” 

 
 
If the calendar does not open you will be given the option of contacting the owner to request they share the 
calendar with you. 

	  



	  

BC	  |	  Information	  Technology	  Services	   52	  

4.	  VIEWING	  A	  SHARED	  CALENDAR	  

Because it is easy in Outlook to accidentally create a meeting on the wrong calendar, it is recommended that 
you only view one calendar at a time. Use the check box in front of each person’s calendar in the left pane 
to hide or show that calendar.  In the following example, only Jonathan McGrath’s calendar is displayed. 
All unchecked calendars (Aaron Wyatt and Calendar) are not shown. 

	  

	  
	  
	  

5.	  REPLYING	  TO	  MEETINGS	  ON	  A	  SHARED	  CALENDAR	  

The owner of a calendar for which you are a delegate, may have opted to have you receive any invitations 
they are sent. If this is the case, you will receive emails for any meeting to which they are invited. As with 

your own meetings invitations, you will have the option to Accept, Decline, or Accept	  Tentatively. As with 
your own calendar, if you or the calendar’s owner, deletes an invitation without acting on it, it will 
disappear from the owner’s calendar. So, neither you nor the owner will have any record of the meeting. 
Be careful not to delete meeting invitations sent to any shared calendars you work with without acting on 
them. 
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6.	  CREATING	  MEETINGS	  ON	  A	  SHARED	  CALENDAR	  

You create a meeting and send invitations on someone else’s calendar the same way you would on your 
own calendar (see Chapter 3). The only difference is that when you send the invitation, internal BC 
recipients will see a note that you are arranging the meeting on behalf of the calendar’s owner. Any 
invitations sent to outside recipients, will look as though they are coming from the calendar owner. 

	  

7.	  REMINDERS	  

If you do not want to receive reminders from your own or other calendars, you can change Outlook’s 
reminder settings. To change the default reminder setting: 

	  
1. Go to Tools >	  Options… 

2. On the Preferences tab, change how far in advance you would like to be notified of meetings and 
appointments. In the example below, a reminder would appear half an hour before an event. 

 
 

If you don’t want to receive any reminders, uncheck Default	  Reminder. 
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8.	  OTHER	  THINGS	  TO	  NOTE	  ABOUT	  WORKING	  AS	  A	  DELEGATE	  

Remember when you work on a shared calendar, anything you do on that calendar will appear on the 
owner’s calendar. For instance, if you use categories to change the color of meeting that color change will 
show up on the owner’s calendar as well if they are using Outlook or Entourage. 
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